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Safety Warnings
Please observe any warnings and follow all instructions.
Do not use this equipment near water and clean only with a dry cloth.
Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
Do not expose to excessive vibration, or drop this product.
Do not defeat the safety purpose of the polarised or grounding-type plug. A polarised plug has two blades with one wider 		
than the other. A grounding-type plug has two blades and a third grounding prong. The wide blade, or the third prong, is provided for your
safety.
If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
Protect the power cord from being walked on or pinched, particularly at plug ends, convenience receptacles, and the point where they exit
from the equipment.
Only use attachments/accessories specified by the manufacturer.
Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment.
Unplug this equipment during lightning storms or when not in operation for long periods of time.
Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as powersupply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, has been exposed to rain or moisture, does
not operate normally, or has been dropped.
To reduce the risk of fire or electric shock, do not expose equipment to rain or moisture.
To avoid electrical shock, do not attempt to open this equipment. Refer servicing to qualified personnel only.
Caution: Media may become hot during normal use.

Disclaimer
Codex products are continually developed to remain at the forefront of the industry, and as such the information in this guide
is subject to change without notice. Whilst Codex endeavour to ensure that all documentation provided is correct at the time of
writing, this document is not guaranteed to be error-free.
Codex does not assume responsibility for issues or losses due to misinterpretation of the information in this document, errors in
this document, or incorrect configuration or installation of the equipment described herein.
Please report any errors found in this document to support@codexdigital.com

Support and Servicing
For assistance with your Codex Vault please contact support@codexdigital.com
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1. Introduction
Welcome to this guide for the Codex Vault, a next-generation modular solution for backup, archive, and dailies production that supports a
range of digital camera systems.
This guide has been designed and written for software version 2014.r2.2027.
An Administrator will set up the Vault and create User accounts for a specific project. The Administrator could be a data workflow specialist,
and the Users could be members of the camera team.
The workflow for the project may involve several Tasks (e.g. copying, backing up, making reports) and the Administrator can design “Work
Templates” which run the Tasks in a given order – when these Tasks are running they are grouped together as a Job. The User(s) operate the
Vault and complete the Tasks guided by a series of on-screen prompts.
Depending on the size of the production, the Administrator may also use the system on a daily basis. On larger productions the Administrator
may configure the Vault initially, and then other Users will operate the system.
This guide will detail how to configure and operate the Vault as an Administrator.

New features
Codex is pleased to announce that the following new features have been added since the previous Vault release (2014.r1.1017):
Metadata editing improvements
From the Library->Edit Metadata screen, the first two tabs for editing metadata now allow switching between different metadata lists, and can
be customised depending on user requirements. See the Edit Metadata section for further details.
Archive to 2 disks at the same time
The Archive task can now write to 2 external disks simultaneously, which are then verified to ensure a secure backup. See the Archive Task
section for further details.
AXSM Media can be cleared
The Media Clear task can now be used for AXSM Media.
GPU acceleration for Generate Task
When a Review module is fitted in the Vault system the GPU is used automatically to provide significantly faster transcode speeds for the
Generate Task. This improvement will provide a large benefit to anyone using the Vault for generating files for editorial or dailies.
Generate from Sony RAW MXF
The addition of GPU accelerated transcodes means that workflows requiring generation of files from Sony RAW MXF are now supported.
Codex Review
When a Review module is fitted this gives access to the Review software. Review consists of four integrated modules – Play, Process, QC, and
Colour – which combine with Vault into a complete playback, dailies and archiving system that deliver your dailies quickly and efficiently, no
matter where you are in the world.
Please refer to the Review Guide for details on using the Review software.
Support for ARRI ALEXA SUP10
This Vault software supports the SUP10 update for ALEXA which includes metadata changes and a new 2578 x 2160 resolution ARRIRAW
option.
General improvements and bug fixes
The software also includes a range of more general improvements and bug fixes to enhance the user experience.
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2. Glossary
AXSM Memory card – a type of solid state media, used in the AXS-R5 recorder for the Sony F55 and F5 cameras.
Capture Drive – a type of Codex recording media, used with the ALEXA XT or Codex Onboard S Recorder and then brought to the Vault for
checking, backup, and archive.
Clip – a clip represents a take, normally from “Roll camera!” to “Cut!”. The term Shot rather than Clip is used in Codex software, but they are
essentially interchangeable. A Shot/Clip will contain image data, metadata, and possibly audio.
Clone (Task) – this process makes an exact copy of all the data from one media to another.
Codex Intermediate Format – files are recorded to a Capture Drive in this format on the Onboard S and ALEXA XT and can then be
transcoded to other file formats using the Vault. (Note: ProRes files recorded on the ALEXA XT are in their native format).
CRC32 – a type of checksum used in the software to verify the integrity of files as they are copied from one media to another.
Datapack – a type of Codex recording media, used with a Codex Onboard M Recorder and then brought to the Vault for checking, backup,
and archive.
Ethernet – a type of network connection between computers.
Generate (Task) – this process transcodes files from the Vault to external storage, for example for editing or dailies, containing as much
metadata as possible.
Job – an active set of Tasks, as configured by the Administrator.
LTFS – Linear Tape File System, a type of formatting for LTO digital archive tape.
LTO – a digital tape media used for data backup.
Media – any type of removable data storage, disk or tape.
Media Clear (Task) – this process deletes data from a specified media.
Media Check (Task) – this process checks media for number and length of clips, and also valid timecode and roll information. It provides a
summary of any issues that have occurred.
Media Sign Off (Task) – this process should be run on media once all other required tasks are complete. It marks that all required tasks are
completed with media so it can be cleared.
Media Verify (Task) – this process checks that disks in media are readable, and that CRC32 checksums are correct.
Metadata – information that relates to the image data such as timecode, roll, Exposure Index, White Balance, Comments, etc. Metadata is
always carried through the system where possible into different file formats.
MUL – when media is loaded the shots are grouped together according to the the name of the media, or Media User Label (MUL). This
typically corresponds to the Roll name. All operations such as cloning and archiving, are performed on one or more of these shot groups.
Network – a connection between computer systems, the most common type of which is Ethernet.
Reel – a metadata property of shots, with multiple shots being recorded to the same reel.
Roll – equivalent to Reel.
Shot – equivalent to Clip.
SR Memory card - a type of solid state media, used in the Sony F65 camera.
SxS card – a type of solid state recording media, used in a range of digital camera systems including the ARRI ALEXA and Sony F5/F55.
Task – one of several possible processes that can be performed on media, such as a Clone or Archive.
Work Template – a set of Tasks that form (part of) the workflow
XFS – a type of disk formatting, used on the Vault Storage Module
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3. Product Elevations
Top Elevation Touchscreen interface.

Right Elevation

Sony AXSM

Capture Drive

REDMAG

Transfer Module ____

Storage Module ____
Archive Module ____
Base ____
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Left Elevation

Note: SS indicates USB3.0 ports (x2)
Rear Elevation
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Front Elevation

4. Modules
There are several modules that can be used to build a Vault system:
• Transfer module – depending on the configuration this allows loading of various media such as Codex Capture Drives, SxS cards, AXSM 		
cards, RED mags, and SSDs.
• Review module - this allows for playback of digital camera originals directly through a Vault for quality control and review via both SDI and
DisplayPort.
• Storage module – this contains 8TB of removable* RAID storage that is used to copy to before archiving and/or transcoding files.
• SR module – this allows loading of two SR Memory cards from the Sony F65 camera.
• Archive module – this contains two LTO5 drives that can be used to make backups.
IMPORTANT – only disconnect and reconnect the modules of the Vault when the power cable is disconnected from the Transfer module.
Note: current models contain a removable Storage pack. In earlier models the whole Storage module can be removed as required.

5. Power
The Vault requires an input voltage of between 20V and 34V. The power required will vary depending on the modules being used, from 350W
up to around 600W.
Only the included Codex power supply should be used for the Vault when running off mains electricity.
Anton VCLX batteries are suitable for powering the Vault when mains electricity is not available.
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6. Starting Up
With a power source connected press the Power Button on the side of the Vault. The Vault takes around 1 minute to start up during which time
you will see the Initialising screen:

When it has finished initialising you will be presented with the Logon screen.

7. Logging In
When the Vault is started you will need to log in, with details provided by the owner of the Vault. Once logged in with an Administrator account
you can set up accounts for other Users as detailed in the later section ‘Settings’ in this guide.
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8. Loading and unloading media
Following the correct procedures for loading and unloading media is very important. Failure to do so may result in damage to the media and
compromise data integrity.
WARNING: Do not unload media when it is reading or writing.
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Note: SS indicates USB3.0 ports (x2)

8.1 Onboard Datapack
Loading – gently insert the Datapack fully into the port. The loading process will begin, and during this time the LED on the Datapack will flash
orange. When the Datapack has loaded the LED will flash green.
Reading/Writing – the LED will be solid green when reading/writing.
Unloading – go to the Stoqrage screen of the Vault User Interface, select the Onboard Datapack, and press Eject. While the Datapack is
unloading the LED on it will flash red. When it becomes constantly red the unloading process has completed. Now pull the lever next to the
Datapack fully to eject it from the port.

8.2 Capture Drive
Loading – gently insert the Capture Drive fully into one of the Codex ports. The loading process will begin, and during this time the LED on the
Capture Drive will flash blue. When the Capture Drive has loaded the LED will flash green.
Reading/Writing – the LED will be solid green when reading/writing.
Unloading – go to the Storage screen of the Vault User Interface, select the Capture Drive, and press Eject. While the Capture Drive is
unloading the LED on it will flash blue. When it becomes constantly blue the unloading process has completed. Now pull the Capture Drive to
remove it from the port.

8.3 REDMAG 1.8”
Loading – gently insert the REDMAG fully into one of the RED ports. The loading process will begin, and during this time the LED next to the
port will flash blue. When the REDMAG has loaded the LED will flash green.
Reading/Writing – the LED will be solid green when reading/writing.
Unloading – go to the Storage screen of the Vault User Interface, select the REDMAG, and press Eject. While the REDMAG is unloading the
LED next to the port will flash blue. When it becomes constantly blue the unloading process has completed. Now pull the REDMAGto remove it
from the port.

8.4 SxS cards
Loading – push the SxS card into one of the two SxS card slots until there is a small click. It will load automatically and a green light will be
shown next to the slot to indicate it is loaded.
Unloading - push the SxS card into the slot to trigger the spring release.
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8.5 SR Memory cards
Loading – open one of the doors on the SR module and push the SR Memory card into the drive. The loading process will begin, and during
this time the lights next to the card slot will flash blue. When the SR Memory card has loaded the lights will be constant blue.
Reading/Writing – the lights next to the SR Memory card will flash green when reading/writing.
Unloading - press the Unlock button next to the card slot, then pull the SR Memory card to remove it from the drive. Do not push the Unlock
button while the card is reading/writing.

8.6 AXSM Memory cards
Loading – gently insert the AXSM memory card fully into one of the AXSM ports. The loading process will begin, and when the AXSM memory
card has loaded the LED will become solid green.
Reading/Writing – the LED will be solid red when reading/writing.
Unloading – go to the Storage screen of the Vault User Interface, select the AXSM memory card, and press Eject. Now pull the AXSM memory
card to remove it from the port.

8.7 External drives and SSDs
The Vault allows general purpose hard drives and SSDs to be loaded via a range of connections: SAS/eSATA. USB3.0, and the 2.5 SSD and 1.8
SSD ports. The drives must be formatted with one of the following filesystems before it can be used with the Vault:
•
•
•
•
•
•
•
•

ExFAT
FAT
Ext3
HFS
HFS+
NTFS
XFS
UDF

Loading – connect the external drive or gently insert the SSD fully into one of the SSD ports. The loading process will begin, and when the
drive has loaded it will be shown on the Storage screen.
Unloading – go to the Storage screen of the Vault User Interface, select the drive, and press Eject. Now disconnect the drive or pull to remove
it from the SSD port.
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9. The Main Menu
After logging in you will be shown the Task Scheduler screen. This is where you can monitor the progress of any Tasks that are running, so the
screen is initially empty.
Select the blue Codex ring at the bottom of the screen to bring up the Main Menu (the blue Codex ring is available from any of the main
screens of the user interface):

The Main Menu provides access to:
•
•
•
•
•
•
•
•

Task Scheduler – to start and monitor the status of Tasks
Library – to access the Review player, edit metadata, and sync audio
Storage – to view details of the loaded media and eject media
Work Package Templates – for setting up the project “Work Templates” that control the workflow
Settings – for creating/deleting user accounts and other system settings (only accessible to Administrators)
Lock Vault – to prevent unauthorised people from using the Vault
Log Out – as above, but also to allow a different user to log in
Power Down Vault – to initiate the shutdown process. Alternatively, press the Power Button on the side of the Vault which will bring up the 		
option to power down the system. The system cannot be powered down if there are active Tasks.
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10. Preparing the Vault for a new project
There are some important steps that should normally be completed before the start of a new project:

10.1 Saving Logs
The first step is to save the system log files, which includes the media history - a record of all the media from a project. Log in with an
Administrator account, open the Main Menu and go to the Settings screen. Select the System tab.

The logs can either be saved onto the Vault itself, or onto a USB stick. If you are saving the logs to a USB stick connect it now.
There is a toggle button for either ‘Default level’ or ‘Full level’. Set this to ‘Full level’, then press Save...
The file browser screen will be shown. If you are saving the logs to the Vault system drive, choose the /tmp directory. Alternatively select your
USB stick.
There will be one file saved, e.g. vaults1048_20130308_142631_logs.tgz
This file is named as follows:
vaults<SerialNumber>_<Date>_<Time>_logs.tgz
The _logs.tgz includes a file called localdb that contains the history of all media that has been processed on the Vault in the most recent project
(i.e. since it was last cleared). It is therefore important to keep a copy of this file for future reference.
It also contains the Work Templates and other more general settings files.
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10.2 Clear Media History
Now you have a backup of the history and settings from the last project, these can be cleared from the Vault. From the Settings screen select
the Project tab.

Press the Clear Media History button, which will delete the localdb file. Doing this will prevent the Vault from reporting clashing media names
during the new project if a name matches media from the previous project.

10.3 Setting up the Storage module
The Storage module can be formatted in two ways, and this determines what type of material can be stored:
Type

Supported material

XFS (RAID-5 XFS)

When formatted in this way, the Storage can contain any format recorded to a Capture Drive and other types of
recording system such as SxS (ProRes), Sony SR Memory, AXSM, RED drives, etc.

Codex (RAID-3 Internal)

When formatted in this way, the Storage can only contain material recorded using the Onboard S recorder, or
ARRIRAW from ALEXA XT.
Performance for Cloning this material is slightly higher to RAID-3 Codex than to RAID-5 XFS. However, flexibility
for different workflows is reduced.
It is not possible to store material from other types of recording system, such as ALEXA XT Capture Drive or SxS
ProRes, Sony SR Memory, AXSM, RED drives, etc.

Open the Main Menu and go to the Storage screen.
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10.4 Reformatting the Storage module
The Storage module may contain shots from the previous project, which will be indicated in the Free Space area by the coloured bar and the
remaining capacity. When the Storage is reformatted these shots will be deleted, so this should only be done if there is confirmation that the
data has been securely backed up to another storage location.
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Reformat the Storage module by the following these steps:
1. Open the Main Menu and go to the Storage screen. Press the Devices button
2. Press to highlight the Storage, and then press the Create button.
3. Set the Name of the Storage (this is limited to 8 characters). Do not use non-alpha numeric characters or spaces.
4. Set the Type as either ‘RAID-5 XFS Internal’ or ‘RAID-3 Codex Internal’ depending on the requirement for your workflow.
5. Press OK and a progress bar will be shown as the drives are formatted as the selected type. Once complete the message “Volume created
successfully” will be shown.
When formatting as RAID-5 XFS the Storage will take several hours to initialise. During this time the RAID is building parity, so it is
recommended to let this process complete before copying any critical data to the RAID.
Also the RAID will not reach maximum performance until the initialization completes, so cloning from multiple media to the RAID during this time
is not recommended.
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11. During a project - Clearing space on the Storage
The Storage Module has a capacity of 8TB, and during a project it can become full and you will need to clear older material (that you know has
been backed up securely, of course!).
1. For safety, go to the Storage screen and eject all other media from the Vault, so that only the Storage is loaded:

2. Open the Main Menu and go to the Library. Press the + icon and then set Filter on Media to the Storage:
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3. Press Filter on Source MUL and then highlight the groups that you want to delete.

4. Press the Filter button to apply this filter, and then press + to return to the main Library view.
5. Press Select All and then press Manage.
6. Press Delete Selected. You will be shown a list of the shots that will be deleted. Press the Delete button to proceed, or if you are not sure
press Cancel.
Note: the Delete Selected function in the Library is only available to Administrator accounts.
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12. Work Templates
Select ‘Work Package Templates’. This is where the Administrator can create and view the different Work Templates on the Vault system. The
Work Templates define the workflow for the Vault on a project, and therefore setting up the Work Template(s) is an important responsibility of the
Administrator.
Note: only Administrator accounts can edit the Work Templates.
The Work Templates screen may initially be empty:

12.1 Creating a Work Template
Select ‘Create a New Template’ and the Template Builder screen is shown:
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At the top of the screen you can edit the name of the Work Template, normally to something self explanatory, e.g. Check and Archive Capture
Drive.
The Work Template can be set to start Automatically, Manually, or both. Simply highlight the setting in blue that is required.
When set to start Automatically the Work Template will begin when media is loaded in the specified port - this could be any port or a specific
port depending on how the Work Template is set up. When set to start Manually the Work Template will be accessible from the Manual Jobs
screen (available from the Task Scheduler screen).

12.2 Adding a Task to the Work Template
A range of possible tasks are shown at the bottom of the screen:

Click a task type to add it. After adding a task, click Add Task again to add further tasks to the Work Template.
The table below gives a brief description of these Tasks:
Task Name

Description

Archive

Copies data to Disk or LTFS tape and then performs verification.

Clone

Makes an identical copy of data from one media to another.

Generate

Generates files for post-production to an external drive.

Media Check

Provides an overview on the contents of media and reports any issues found.

Media Verify

Performs a checksum-based verification of media.

Media Clear

Reformats the specified media.

Media Sign Off

Marks that all required tasks are completed with media so it can be cleared.

Import

Imports files from an external disk or LTFS tape

The next image shows the Template builder screen with Media Check and Archive Tasks that have been added:
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Important Note: a Task is considered complete when it finishes - for any reason. For example rather than completing as expected, a Generate
task could stop due to an error with the external disk (e.g. power loss). If this happened the Vault would still proceed with subsequent tasks in
the template (because you may still want to perform an Archive to LTFS despite the disk issue). It is therefore important to confirm on the Task
Scheduler that tasks have completed as expected.
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For each Task you can specify a more descriptive name, e.g. ‘Clone from Capture Drive to Internal’. By default each Task is simply called by its
type, e.g. ‘Clone’, ‘Archive’, etc. If there is more than one of the same task type they must be given unique names.
Any Task can be removed from the Template using the Delete button, and the order of the Tasks in the Template can be changed using

														
For most Tasks there is a ‘From:’ field for which you select the media that is used as the input for the Task (where the data is coming from).
Some Tasks also have a ‘To:’ field for which you select the media that is used as the output for the Task (where the data is going to). Setting up
the expressions for the ‘From:’ and ‘To:’ fields is described in the section ‘From and To Expressions’.
Some Tasks have an option to ‘Eject Output’. This means that when the Task has completed the media used as the output for the Task will be
ejected from the Vault and it can be safely removed.
For most Tasks there are ‘Settings’ that can be chosen. Full options for each task type will be described later in this guide.
Once you have finished defining a Work Template select Save & Finish. (If you don’t want to save the Work Template, select Quit & Forget.) It
will be added to the list of Work Templates on the system:

From this screen you can set whether a Work Template is Active. If a Work Template is set to start Automatically then it will only be able to start
when it is Active. If a Work Template is set to start Manually then it will only be shown on the Manual Jobs screen when it is Active.
You can also choose to Edit or Delete any Work Template from this screen.
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13. From and To Expressions
In the ‘From:’ and ‘To:’ fields for a Task we can set expressions, which are used to define where the source and destination media are loaded.
Next to the ‘From:’ or ‘To:’ fields there is an ‘Add expression’ button:

Select the Add expression button to open a list of categories for different media ports on the Vault:
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Choose the relevant category and then select the media port you would like to use. You can select a specific media port or in some cases
select to use Any of a particular type of media port:

In the From: field the full expression will then be automatically inserted.
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Most Tasks require a ‘‘From:’ expression that specifies the {MediaPort} - physical location of the media - for the Task. So in this case the Media
Check will run on the media that is loaded in the CODEX 1 port.
In addition to an input expression the Clone process also requires an output expression in the ‘To:’ field, as shown here:

This Task will clone material from the media loaded in the CODEX 1 port to Internal 1 (Storage Module).
The Add expression button allows the most common expressions to be entered very easily. More advanced users can enter expressions
manually if required, using the information in the appendix.

13.1 Full options in Add Expression
These diagrams show how the options in Codex Ports and Third Party Ports correlate to the physical ports on the Vault:
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The options that are prefixed with Any, such as ‘Any Codex’ or ‘Any SxS’ can be used to scan all ports of that type for media to use for a task.
The Storage module is selected by choosing an option from the Internal list:
•
•
•
•

Internal 1 - use to select the first fixed Storage module (closest to the Transfer Module).
Internal 2 - use to select the second fixed Storage module if two are installed.
Removable 1 - use to select the first removable Storage module (closest to the Transfer Module).
Removable 2 - use to select the second removable Storage module if two are installed.

The Common Expressions list gives the following options:
• Only If Media Is Empty - use to specify that the destination for a Clone task is required to be empty
• Media: Same as previous task input - can be used when there are several tasks grouped together in a Work Template. A task will process a
given media and the use of this option in the From expression for the next task means it will use that same physical media.
• Media: Same as previous task output - can be used when there are several tasks grouped together in a Work Template. A task will output to
a specified media and the use of this option in the From expression for the next task means this will use that same physical media.
• Source clips: Same as previous task - can be used when there are several tasks grouped together in a Work Template. A task will process a
group of shots and the use of this option in the From expression for the next task means it will also process the same shots (it may be a copy
of the shots on a different media).
• Source clips: Same as first task - can be used when there are several tasks grouped together in a Work Template. The first task will process
a group of shots and the use of this option in the From expression for any subsequent tasks means they will also process the same shots (it
may be a copy of the shots on a different media).
Note: you must manually add “ and “ in between an option from Internal, Codex Ports, or Third Party Ports and an option from Common
Expressions, e.g. {MediaPort} = “Vault Codex data pack 1” and {MUL} = {InitialTaskMULList}
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14. Task Types
14.1 Selecting a MUL for a Task
As a general note for all tasks, if the source media contains more than one group of shots (MUL), the User is given the option to select which to
involve in the task. When this is the case a list of available MULs are shown but none are initially selected. The User must manually set which
MULs will be involved in the task:

An example is where the Storage module is used as the source media for a task. The Storage is normally used as a destination for cloning data
to, and after several Capture Drives have been cloned to the Storage it will contain shots from several MULs.
If an Archive task is then run using the Storage as the source the User can select which MULs to include.
The Tasks will now be discussed in more detail. They are presented on the Vault screen in alphabetical order, but they will be discussed in the
order they are more likely to be used.

14.2 Clone Task
The Clone Task is normally the first task performed on media when it is loaded.
Note: the Clone Task must be used to copy from third party media (SxS, SR Memory, AXSM, REDMAG) onto XFS formatted Storage before any
other task can be performed with these files.
The Clone Task makes an identical copy of data from one media to another. This includes all data – image, audio, and metadata.
The Source and Destination media need to be compatible:
Source Media

Clone to Storage Module RAID-5 XFS

Clone to Storage Module RAID-3 Codex

Capture Drive (Codex Intermediate Format)

Yes

Yes

Capture Drive (ProRes from ALEXA XT)

Yes

No

AXSM Memory Card

Yes

No

SxS Memory Card

Yes

No

SR Memory Card

Yes

No

REDMAG

Yes

No
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WARNING: If material has been cloned from a Capture Drive (Codex Intermediate Format) to RAID-5 XFS then DO NOT:
a) revert the Vault to software version 2013.r1.3509 or earlier.
b) move a fixed RAID-5 XFS Storage module to a Vault running software 2013.r1.3509 or earlier.
c) transfer a removable RAID-5 XFS Storage module cartridge to a Vault running software 2013.r1.3509 or earlier.
Doing any of these things will result in the shots becoming permanently inaccessible.
There is an Eject Output option for a Clone Task – if this is highlighted then the target media will be automatically ejected from the system once
the Clone task has finished.
For Capture Drives in the Codex Intermediate Format the Clone Task will read the source data and create CRC32 samples that are compared to
the copy, ensuring data integrity. If the source data already has CRC32 samples then the system will compare these to the copied data also.
For files from third party media an md5 verification is performed during the Clone process.
14.2.1 Dual Clone
The Clone Task can be used to clone data to two targets at the same time. This can only be set up for cloning between media formatted as
Codex Intermediate Format. It cannot be used when cloning from third party media (SxS, SR Memory, AXSM, REDMAG).
When setting up the template dual clone is achieved by including details of each target in the To: expression for the task separated by a semicolon (;) symbol. For example:
{MediaPort} = “Vault Codex data pack 1”;{MediaPort} = “Vault Codex data pack 2”
Setting this up as a Work Template is shown below:

14.3 Media Check Task
Note: Media Check cannot be run on third party media (SxS, SR Memory, AXSM, REDMAG). The contents of this media should first be Cloned
to XFS formatted Storage and the Media Check performed on the copy.
The Media Check Task provides the following information:
• Reports the number of shots and frames on the media.
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•
•
•
•

Provides a summary of the video/audio/timecode formats on the media.
Checks for duplicate timecodes.
Checks for duplicate shot names.
Reports any issues found during these checks.

In the example shown below, the video format information displayed means:
Format attribute

Description

2178p

Image height and scan format.

25.00

Frames per second.

10B

Image sample bit depth, e.g. 10-bit.

R

Colourspace, i.e. RGB Bayer. The other possibility is Y meaning YCbCr.

V1

Number of video channels.

A2

Number of audio channels.

Here is an example of the results from a Media Check task:

This shows a Media Check where no issues have been found.
The User could optionally press to view the Library (as described in the later section), where they can check metadata, view on screen
playback, and sync audio.
They can then proceed by selecting from the given options:
•
•
•

OK – this should be selected if the user agrees with the results of the Media Check. The Vault then proceeds with any subsequent tasks
that have been configured.
Not Sure – this should be selected if the user is not sure that the results of the Media Check match their expectations. The Vault then
proceeds with subsequent tasks, but any PDF reports produced later will show that the user did not mark the Media Check as ‘OK’.
Cancel – this should be selected if the user does not agree with the results of the Media Check. The Vault will not proceed with
subsequent tasks in that Work Template.

14.3.1 Media Check Information
The Media Check always provides the following information:
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MUL: - this is the Media User Label for the media that is being checked (followed by the media location in brackets)
MULFilter: - if a selection of shots are included based on their MUL, this is shown here
Num good shots: - shows how many shots from the total have no issues detected
Num good frames: - show how many frames from the total have no issues detected
Depending on what is found during the Media Check some of the following information may also be displayed.
These messages are for information and no action is required:
All shots have same video format
All shots have same audio format
All shots have same timecode format
No audio
These messages may or may not be expected depending on the project:
WARNING X different video formats
WARNING X different audio formats
WARNING X different timecode formats
These messages provide warnings that are important to prevent issues in post-production:
WARNING X/Y shots have timecodes which clash with other shots
WARNING X/Y shots have timecode clashes if normalised to 24fps SMPTE
WARNING X/Y shots have timecode breaks/repeats
WARNING X/Y shots names are not unique
The image below shows a Media Check where issues have been found:

If there is more than one shot with the same name, there will be a Fix Name Dupes button shown. Pressing this will add a number in brackets to
the end of any duplicate shot names. For example:
Original Shot Names

Shot Names After “Fix Name Dupes”

1-1_A001

1-1_A001

1-1_A001

1-1_A001(2)

1-1_A001

1-1_A001(3)
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14.4 Archive Task
14.4.1 Tape and Disk Archive options
The Archive Task performs a Backup (and Verify) operation of files to external Disk or Tape using the LTO5 drives in the Vault.
An external disk can be formatted with any of the following supported filesystems:
•
•
•
•
•
•
•
•

ExFAT
FAT
Ext3
HFS
HFS+
NTFS
XFS
UDF

The image below shows the Archive Settings screen:

The Disk Archive can be made to 1 or 2 external disks, as specified in the settings for the task. When using large disks (e.g. >4TB) it is good
practice to format with multiple smaller partitions to assist with data management.
The LTO tapes for an Archive task are formatted by the Vault as LTFS (Linear Tape File System), which is an open standard. By default the
system will do a dual tape archive. This can be changed to a single tape archive by editing a system configuration file. For more information on
changing this system configuration contact Codex support.
After adding an Archive Task to the Template, select Settings and set the Target as Disk or LTFS. When Disk is selected there is also the option
to set if 1 or 2 backups will be made, and to Predefine Filepath to the disk(s) that files will be written to.
Set the Operation as Backup, Backup And Verify, or Verify.
The Backup And Verify option copies the files and then does a byte-for-byte verification by comparing what is on the disk/tape to the original
data. This is the recommended setting.
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If Backup is used then the Verify option can be used later, and this compares what is on the disk/tape with md5 checksum files that were
created from the original data. These md5 files are stored on the Vault – therefore the Verify must be performed on the same machine as the
Archive task.
Set the Frame Rate to match the editing rate for the project. This is very important to allow successful conforming from the archive to editorial
files used later in post-production.
There is also an option to Add Other Files. This can be used to include any other files in the Archive. An example might be sound files brought
to the Vault on a USB stick. Set this option to Yes and then use the browser to set the path for the Other Files Location.

14.4.2 File types and structure of Archives
For material recorded on third party media (SxS, SR Memory, AXSM, REDMAG), after cloning to XFS Storage the file types and directory
structure are copied directly onto the disk/tape when the Archive task is performed.
For material recorded on a Capture Drive the file types and directory structure for the Archive Task is as follows:
File Type

Description

ari

Per frame files for ARRIRAW material, containing extensive metadata

dpx

Per frame files for all other material, containing essential metadata. These are Uncompressed dpx files in the same
colourspace as the source data.

bwf

Per shot Broadcast WAV audio files, containing timecode and roll metadata.

xml

Per shot Codex metadata files, containing all metadata (with the exception of per frame metadata)

rmf

Per frame files for Canon Cinema RAW material, containing extensive metadata

Directory Structures In Archive:
ari - <SourceMediaId>/<Roll>/<Extension>/<Roll>.<Shot>.<UniqueID>/<Shot>.<TC Frames>.<Extension>
dpx - <SourceMediaId>/<Roll>/<Extension>/<Roll>.<Shot>.<UniqueID>/<Shot>.<TC Frames>.<Extension>
bwf - <SourceMediaId>/<Roll>/<Extension>/<Roll>.<Shot>.<UniqueID>/<Shot>.<Channel>.<Extension>
xml - <SourceMediaId>/<Roll>/<Extension>/<Roll>.<Shot>.<UniqueID>/<Shot>.<Extension>
rmf - <SourceMediaId>/<Roll>/<Shot>/<Shot>_<Frame Number>.<Extension>
bwf - <SourceMediaId>/<Roll>/<Shot>/<Shot>_00000001.<Extension>
xml - <SourceMediaId>/<Roll>/<Shot>/CLIPINFO.XML
ari - <SourceMediaId>/<Roll>/<Extension>/<Roll>.<Shot>.<UniqueID>/<ChannelID>/<Shot>.<TC Frames>.<Extension>
dpx - <SourceMediaId>/<Roll>/<Extension>/<Roll>.<Shot>.<UniqueID>/<ChannelID>/<Shot>.<TC Frames>.<Extension>
Note: the .rmf and second .bwf and .xml structures coloured green will only be used for Canon Cinema RAW recordings. The structure allows
these files to be loaded into third party software such as Canon Cinema RAW Development. The second .ari and .dpx structures coloured blue
will only be used for 2-channel (generally Stereo 3D) shots. The files for each eye are contained in a separate folder, and the Roll metadata
includes the Channel ID, e.g. left eye Roll A001L, right eye Roll A001R.

14.4.3 Prompts during the Archive Task
New tapes have to be formatted when an Archive Task starts, which takes a couple of minutes. In this case the following prompt will appear:

CODEX VAULT - ADMINISTRATOR GUIDE - 2014.r2.2027

PAGE 33

During the formatting process the system will prompt for a tape name:

Typically this would match the barcode label. There should be no spaces in tape names.
When the Archive process starts a message will be displayed that says ‘Status: Applying shot filter…’ – this may be shown for several minutes
whilst the system prepares to run the archive.
The disk/tapes will then be mounted, which may take a minute or two. Then a prompt will appear asking for a user-friendly name for the offload
for logging purposes:

Typically this would match the Roll metadata for the material that is being archived, but anything can be entered.
In the case of a disk Archive you will also be prompted to enter a name for the disk for tracking purposes.
The system will then proceed with the Archive.

14.5 Generate Task
The Generate Task can be used to output a range of file types to external disk for post-production.
If a Review module is installed in the Vault then the GPU will be used to accelerate the transcoding processes.
Note: the Generate Task is not compatible with RED RAW R3D files.
When preparing the Generate Task, select Settings to define the File type and any other options for it. Each Generate Task is configured for a
single file type, but you can set up multiple Generate Tasks to run in a sequence or in parallel as part of your Work Template.
14.5.1 Settings for different file types
The table below shows the different image/audio file types and options available for them:
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Option | File Type >
Audio file type
None
wav
BWF
Directory

dpx

bmp

jpg

ari

rmf

avi

mov

mxf

For still image files this setting determines if associated audio is also generated. 'wav' files contain only audio - 'BWF' files also contain timecode and roll metadata.

✔
✔
✔

✔
✔
✔

✔
✔
✔

✔
✔
✔

✔
✔
✔

✔
✔
✔

✔
✔
✔

✔
✔
✔

Set the base directory structure that the files are contained in. See options in section ‘Base Directory options’.

Eject External Media

When the Generate task completes set if external media used is ejected, or if the user if prompted to choose.

First frame
<User Input Value>

Leave this field blank to generate files for entire shots. If required a value can be entered here to start generating files from a specified frame number in the shots.

Num frames
<User Input Value>

Leave this field blank to generate files for entire shots. If required a value can be entered here to only generate files for a specified number of frames in the shots.

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔

✔
✔

✔

✔

✔

✔

Specify the Lut(s) to apply to files here. The software supports a range of LUT file formats, detailed in the 'LUTs Guide'.

Scaling
None
Scaling factor specified
Fixed size specified

Images can be scaled for some file types if required. Scaling can be done either to a factor of the original image size, or to a specified width and height.

✔
✔
✔
✔

✔
✔
✔
✔

Scale factor
1/2
1/4
1/8
1/16

Choose the required Scale Factor here.

Scale width
<User Input Value>

Specify the required image Width here.

Scale height
<User Input Value>

Specify the required image Height here.

Roll transform
Append Channel ID
Prepend Channel ID
File numbering
Frame number
Frames since midnight
Compression
DNxHD 422
DNxHD 444
ProRes 422
ProRes 4444
jpeg
Compression Quality
High
Medium
Low
Conversion Quality
High
Medium
Low
Audio
Mono
Stereo
DPX
Keep Existing Format
Convert to 10-bit RGB
Uncompress
Convert to 12-bit RGB
Convert to 16-bit RGB

✔
✔
✔
✔
✔
✔

✔
✔
✔
✔
✔
✔

✔

✘

✘

✔

✔

✔

Lut
<User Specified Lut>

Burn-in
<User Specified Burn-In>

✔
✔
✔

Set the directory that the files will be exported to here. This is typically to an external drive connected to the Vault. Leave this blank to choose from mounted volumes when the Generate task begins.

Base Directory

FPS
23.98
24.00
25.00
29.97
30.00
47.95
48.00
50.00
59.94
60.00
Natural
Interlace
No
Yes

3D DNxHD mxf

✔
✔
✔

✘
✘
✘

✘
✘
✘

✔
✔
✔

✔
✔
✔

✘
✘
✘

✘
✘
✘

✔
✔
✔
✔

✘
✘
✘
✘

✘
✘
✘
✘

✔
✔
✔
✔

✔
✔
✔
✔

✘
✘
✘
✘

✘
✘
✘
✘

✔

✘

✘

✔

✔

✘

✘

✔

✘

✘

✔

✔

✘

✘

This should generally be set to the project rate. (Otherwise files will be generated at the Natural [shooting] frame rate, which may vary, causing issues in post production).

✔
✔
✔
✔
✔
✔
✔
✔
✔
✔
✔

✘
✘
✘
✘
✘
✘
✘
✘
✘
✘
✘

✘
✘
✘
✘
✘
✘
✘
✘
✘
✘
✘

✔
✔
✔
✔
✔
✔
✔
✔
✔
✔
✔

✔
✔
✔
✔
✔
✔
✔
✔
✔
✔
✔

✔
✔
✔
✔
✔
✔
✔
✔
✔
✔
✔

✔
✔
✔
✔
✔
✔
✔
✔
✔
✔
✔

✔
✔
✔
✔
✔
✔
✔
✔
✘
✘
✔

✔
✔
✔
✔
✔
✔
✔
✔
✔
✔
✔

✘
✘

✘
✘

✘
✘

✘
✘

✔
✔

✔
✔

This option can be used to create Interlaced mxf files.

✘
✘

✘
✘

✘
✘

Specify the Burn-in to apply to files here. There are preset Burn-ins for Masking, Timecode, Shot/Roll etc. Users can also refer to the 'Burn-Ins Guide' to create custom burn-ins.

✔

✔

✔

✘

✘

✔

✔

✔

✔

This option can be used for multi-channel shots (Stereo rig, or A/B cameras, to a Codex recorder), so that files for each camera have unique Roll metadata in the file header.

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

This option sets if file sequences are numbered based on the Frame Number in the shot starting from 00001, or from the timecode converted to a 7-digit Frames Since Midnight value (at the recorded speed)

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✘
✘

✘
✘

✘
✘

✘
✘

✔
✔
✔
✔
✔

✔
✔
✘
✘
✔

✔
✔
✘
✘
✘

✔
✔
✔

✔
✔
✔

✔
✔
✔

Select the compression codec used for editorial/dailies files here. See the section 'Compression Quality settings' for details.

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

✘
✘
✘
✘
✔

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

✘
✘
✘
✘
✔

This setting relates to the selected Compression option. See the section 'Compression Quality settings' for details.

✘
✘
✘

✘
✘
✘

✔
✔
✔

✘
✘
✘

✘
✘
✘

✔
✔
✔

This option determines the quality of: De-Bayering, Colourspace conversion, and Scaling operations. High will give the best results, but take longer than Medium or Low.

✔
✔
✔

✔
✔
✔

✔
✔
✔

✘
✘
✘

✘
✘
✘

✔
✔
✔

✔
✔
✔

✔
✔
✔

✔
✔
✔

For editorial/dailies files this determines the embedded audio. For image sequences this setting determines whether 'wav' or 'BWF' files are generated as Mono or Stereo.

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✔
✔

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

✘
✘
✘
✘
✘

This option determines the format of dpx files that are generated.

✔
✔
✔
✔
✔
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14.5.2 Base Directory options
This setting controls the directory (folder) structure that is written above the files.
•
•
•
•

{Roll}/ - there is a Roll folder at the top, the default for stream files such as mov and mxf
{Roll}/{Shot}/ - there is a Roll folder and then a Shot folder at the top, the default for file sequences such as ari and dpx
{ProductionName}/{ShootDate}/{Day}/{Roll} - additional folder levels for Production Name, Shoot Date, and Day metadata are written.
{ProductionName}/{ShootDate}/{Day}/{Roll}/{Shot} - additional folder levels for Production Name, Shoot Date, and Day metadata are 		
written.

14.5.3 Setting the destination for a Generate Task
The Vault will auto-mount external drives that are formatted with the following filesystems:
•
•
•
•
•
•
•
•

ExFAT
FAT
Ext3
HFS
HFS+
NTFS
XFS
UDF

When using large disks (e.g. >4TB) it is good practice to format with multiple smaller partitions to assist with data management.
Drives can be connected to the following ports on the Vault:
•
•
•
•
•

SAS (a cable is available to connect up to 4 eSATA devices to the SAS port)
USB 2.0
USB 3.0
2.5” SSD
1.8” SSD

In the settings for the Generate Task leave the Directory field blank or containing a * if you want to choose the location of the external drive
when the task starts:
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If the mounted device/directory is always the same then the exact path can be specified in the Directory field when setting up the Generate
Task. Click the ... symbol to choose a directory:

A top level directory will always be created on the drive used for the Generate Task, which is given a unique name based on the date and time
the task was started in the following format:
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generate_DDMMYY_HHMMSS
This is then followed by folders defined by the Base Directory setting.
By default per-shot files such as .mxf or .mov will be copied into a Roll folder within the main generate folder:

By default for per-frame files such as .ari or .dpx, the generate folder will contain a folder for each shot, and the individual files will be in these
folders.

The Base Directory setting will determine if there are additional folder levels for Production Name, Shoot Date, and Day.
Each Generate Task automatically creates an ALE (Avid Log Exchange) file called generate.ale in the main generate folder. The ALE can be
used to bring all the original shot metadata into Avid.
14.5.4 Compression Quality Settings
When using ProRes 422 or DNxHD compression there is a Compression Quality setting available. Below are details on how this setting relates
to the compression codec that is used.
ProRes 422:
Compression Quality

ProRes 422 codec

High

ProRes 422 HQ

Medium

ProRes 422 LT

Low

ProRes 422 Proxy

DNxHD 422:
Compression Quality

Frames per second

DNxHD 422 codec

High*

23.98/24

DNx175/DNx175x

25

DNx185/DNx185x

29.97/30

DNx220/DNx220x

23.98/24

DNx115

25

DNx120

29.97/30

DNx145

Medium

Low
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* Using High Compression Quality the DNx codec will be 8-bit for source material that is captured as 8-bit.The DNx codec will be 10-bit for
source material that is captured as 10-bit or higher. Medium and Low Quality will use an 8-bit DNx codec.
DNxHD 444:
Frames per second

DNxHD 444 codec

23.98/24

DNx360x

25

DNx370x

29.97/30

DNx440x

When mxf files are generated, for any shots with audio there will be a video mxf as well as audio mxf files. For example, if shot 1-1_A001 has
two audio channels then generating an mxf will result in three files:
1-1_A001V1.mxf
1-1_A001A1.mxf
1-1_A001A2.mxf
These video and audio mxf files contain metadata so that when they are loaded into an Avid edit system they will be linked automatically.
As well as image/audio files the Vault can also generate some metadata file types:
CodexShot xml – these files are generated per-shot and contain a wide range of metadata that can be used in post-production with custom
tools.
FinalCut xml – this file is designed to allow easy organisation of mov files in FCP. There is one file generated for all shots that can be loaded into
FCP along with the media, and the software then automatically creates bins for the media.
ASC CDL xml – these files are generated per-shot for any shots with CDL Data (captured from Truelight TL Onset software, Pomfort LiveGrade,
or Framewright LinkColor). They can be used later in post-production software to apply the same LUT that was used on set.
Metadata txt – this file is for proprietary metadata and should not be used under normal circumstances
14.5.5 Applying LUTs and Burn-Ins
The Vault can apply 1D LUTs, 3D LUTs, CDL Data and burn-ins to deliverable files. The most common use of this feature is for editorial and
dailies files to have a colour corrected image, optionally with production information and a watermark.
When in the Settings for a Generate Task there are separate boxes to specify LUT and Burn-In files.
To load your own LUT files to the Vault see the later section ‘Loading LUTs to the Vault.’
There are a range of pre-loaded LUT and Burn-In files available to choose from on the Vault:
LUT Name

Description

C3vid_F.lut
C3vid_L.lut

Canon LUTs for C500 recordings. These are 1D LUTs to scale the image values to either Full range or Legal
range, giving more contrast than the native Canon Log image.

EI160_EE_codex3d.lut
EI200_EE_codex3d.lut
EI250_EE_codex3d.lut
EI320_EE_codex3d.lut
EI400_EE_codex3d.lut
EI500_EE_codex3d.lut
EI640_EE_codex3d.lut
EI800_EE_codex3d.lut
EI1000_EE_codex3d.lut
EI1280_EE_codex3d.lut
EI1600_EE_codex3d.lut
EI2000_EE_codex3d.lut
EI2560_EE_codex3d.lut
EI3200_EE_codex3d.lut

ARRI LUTs for ALEXA LogC recordings. These 3D LUTs convert from LogC to Rec709. They resulting values
are Extended range, so these LUTs are suitable for creating ProRes .mov files.
If you have material with a range of Exposure Index values, use this as the LUT setting to apply the correct
LUT based on Exposure Index metadata:
EI{ExposureIndex}_EE_codex3d.lut
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EI160_EL_codex3d.lut
EI200_EL_codex3d.lut
EI250_EL_codex3d.lut
EI400_EL_codex3d.lut
EI320_EL_codex3d.lut
EI500_EL_codex3d.lut
EI640_EL_codex3d.lut
EI800_EL_codex3d.lut
EI1000_EL_codex3d.lut
EI1280_EL_codex3d.lut
EI1600_EL_codex3d.lut
EI2000_EL_codex3d.lut
EI2560_EL_codex3d.lut
EI3200_EL_codex3d.lut

ARRI LUTs for ALEXA LogC recordings. These 3D LUTs convert from LogC to Rec709. They resulting values
are Legal range, so these LUTs are suitable for creating DNxHD .mxf files.
If you have material with a range of Exposure Index values, use this as the LUT setting to apply the correct
LUT based on Exposure Index metadata:
EI{ExposureIndex}_EL_codex3d.lut

Click the Add Lut button to open a browser and highlight/Select a LUT file from those loaded on the Vault. Repeat this process to add multiple
LUTs to a file type:

To apply one of the pre-installed LUTs based on the Exposure Index metadata of the clip, change the value in the filename to be
{ExposureIndex} as shown below:
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If the clips were recorded with CDL Data, click the Add CDL button to burn this look into the files:

CODEX VAULT - ADMINISTRATOR GUIDE - 2014.r2.2027

PAGE 41

Burn In Name

Description

Framecount_BottomCentre.xml
Framecount_BottomLeft.xml
Framecount_BottomRight.xml
Framecount_TopCentre.xml
Framecount_TopLeft.xml
Framecount_TopRight.xml

Overlays a frame count, starting from 00000, at the indicated position on the image.
Text is white.

Framelines_185_Full_Width_1920.xml
Framelines_185_Full_Width_2880.xml
Framelines_185_With_5_Percent_Safe_1920.xml
Framelines_185_With_5_Percent_Safe_2880.xml
Framelines_239_Full_Width_1920.xml
Framelines_239_Full_Width_2880.xml
Framelines_239_With_5_Percent_Safe_1920.xml
Framelines_239_With_5_Percent_Safe_2880.xml
Framelines_240_Full_Width_1920.xml
Framelines_240_Full_Width_2880.xml
Framelines_240_With_5_Percent_Safe_1920.xml
Framelines_240_With_5_Percent_Safe_2880.xml

Overlays 1 pixel thick lines showing the defined aspect ratio over the image. There are
also 5_Percent_Safe options that move the framelines a further 5% towards the middle
of the image in all directions. The framelines are white.

Logo_Large_Transparent_Centre.xml
Logo_Medium_Transparent_Centre.xml
Logo_Small_Opaque_BottomLeft.xml
Logo_Small_Opaque_BottomRight.xml
Logo_Small_Opaque_TopLeft.xml
Logo_Small_Opaque_TopRight.xml
logo.png

Overlays the logo.png file (see next section for how to load a new logo.png file).

Mask_185_Full_Width.xml
Mask_185_With_5_Percent_Safe.xml
Mask_239_Full_Width.xml
Mask_239_With_5_Percent_Safe.xml
Mask_240_Full_Width.xml
Mask_240_With_5_Percent_Safe.xml

Overlays a 50% opaque mask to provide the defined aspect ratio. There are also
5_Percent_Safe options that move the mask a further 5% towards the middle of the
image in all directions.

Roll_and_Shotname_BottomCentre.xml
Roll_and_Shotname_BottomLeft.xml
Roll_and_Shotname_BottomRight.xml
Roll_and_Shotname_TopCentre.xml
Roll_and_Shotname_TopLeft.xml
Roll_and_Shotname_TopRight.xml

Overlays the Roll name and Shot name at the indicated position on the image.
Text is white.

Roll_BottomCentre.xml
Roll_BottomLeft.xml
Roll_BottomRight.xml
Roll_TopCentre.xml
Roll_TopLeft.xml
Roll_TopRight.xml

Overlays the Roll name at the indicated position. Text is white.

Shotname_BottomCentre.xml
Shotname_BottomLeft.xml
Shotname_BottomRight.xml
Shotname_TopCentre.xml
Shotname_TopLeft.xml
Shotname_TopRight.xml

Overlays the Shotname name at the indicated position. Text is white.

Timecode_and_Framecount_BottomCentre.xml
Timecode_and_Framecount_BottomLeft.xml
Timecode_and_Framecount_BottomRight.xml
Timecode_and_Framecount_TopCentre.xml
Timecode_and_Framecount_TopLeft.xml
Timecode_and_Framecount_TopRight.xml

Overlays the Timecode and Framecount at the indicated position. Text is white.
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Timecode_BottomCentre.xml
Timecode_BottomLeft.xml
Timecode_BottomRight.xml
Timecode_TopCentre.xml
Timecode_TopLeft.xml
Timecode_TopRight.xml

Overlays the Timecode at the indicated position. Text is white.

Click the Add box next to the Burn-In field to open a browser and highlight/Select from the files available on the Vault. Repeat this process to
add multiple Burn-Ins to a file type:

v
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14.6 Import Task
The Import Task can be used to import files from an LTFS archive completed on the Vault or from an external disk (e.g. attached USB or eSATA
hard drive).
If the files were archived from Codex formatted Storage they should be imported back to Codex formatted Storage. Similarly, if they were
archived from XFS formatted Storage they should be imported back to XFS formatted Storage.
Once the files have been imported then they can be processed using other types of task, such as a Generate.
In the Settings for the Import Task you can select if the Source for the import is File (disk) or Tape (LTFS).
For file sequences the Num Frames setting allows you to set how many frames will be imported, which can be useful if you are checking an
archive and want to check a sample of frames rather than whole shots.
If the files for import will always be in the same directory set Predefine Filepath to Yes and specify the correct location. If Predefine Filepath is
set to No then when a file Import task runs the user selects the location of the files to import using a the file browser.
When importing from an LTFS tape the left hand tape drive is used.
Start the Import and a list of the archives on the tape will be presented:
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Select the archive you want to import from and a list of the shots will be displayed. Either manually select the shots to import:
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Then use the Import Selected button, or alternatively the Import All button, at the bottom of the screen:
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14.7 Media Sign Off Task and PDF Reports
The Media Sign Off provides PDF Reports for the media, and also marks the media as ‘finished with’ meaning a Media Clear task can be run
without prominient warnings.
Note: the Media Sign Off Task cannot be run directly on third party media (i.e. SxS, AXSM, SR Memory, REDMAG). Instead use the Media Sign
Off Task on the copy of files made from this media to XFS Internal formatted storage to produce PDF Reports.
The Media Sign Off task provides the following prompt:

The Media Sign Off task can produce a range of reports:
Media Report – provides a PDF report with a summary on the contents of the media and the history of jobs/tasks that have been carried out
with the media.
Job Report – provides a PDF report on the current running job that the media is involved in.
Shot Report – provides a PDF report of the shots on the media, with key metadata such as Roll, Timecode, Duration, File size, and Format.
Here is an example of a Shot Report:
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Each type of PDF Report needs to be saved separately.
When viewing a report, click the ... button next to the Path field. From here the User can select an external device which is recommended (e.g.
USB Stick). After saving the reports select from the following options.
Confirm – when the Confirm button is pressed the Vault marks the media as signed off (i.e. all required tasks have been completed) and a
Media Clear can be carried out without any warnings
Cancel – cancels the Media Sign Off, meaning effectively that the media is not finished with.
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14.8 Media Clear Task
The Media Clear Task formats the media so that it can be used again.
When setting up a Media Clear task in Settings you can specify:

Create new volume: Yes or No.
If this is set to No (recommended), the media will need to be reformatted with a new Roll number before it can be used. This is normally done in
the camera or recorder on set.
If this is set to Yes the media will be reformatted with a new Roll number, and the additional option will be available:
User sets new label: Yes or No.
If this is set to Yes the user will be asked to input a new Roll number for the media.
If this is set to No the Vault will automatically create a new Roll with a length of 8 characters on Codex media, incremented from the previous
Roll number. Here are some examples of Roll numbers created automatically by the Vault:
Previous volume name

New volume name created automatically by Vault

001

00100002

00100002

00100003

204

20400002

A263

A2630002

SxS, AXSM and SR Memory cards will be cleared and given the name CODEX_BLANKED. These should be reformatted in the camera before
use.
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If a Media Sign Off has not been completed before the Media Clear then a prominent warning will be displayed as shown below:

14.9 Media Verify Task
The Media Verify Task can be used to verify the integrity of shots if this needs to be checked for any reason. It reads the data and compares
this to the checksums originally calculated, to make sure they are still consistent. As such it is not a Task that needs to be commonly employed
as part of a workflow, but generally only if problems are experienced reading or writing the media.
In the Settings select whether Create CRC32 samples or Repair CRC32 samples is performed as part of the task.
Note: the Clone Task already performs checksum verification by default on any files that are copied in the system.
Note: the Media Verify Task cannot be run directly on third party media (i.e. SxS, AXSM, SR Memory, REDMAG). Instead use the Media Verify
Task on the copy of files made from this media to XFS Internal formatted storage.

CODEX VAULT - ADMINISTRATOR GUIDE - 2014.r2.2027

PAGE 50

15. Task Scheduler
The Task Scheduler is the main screen that the User will interact with on a daily basis. It displays progress information about active Jobs (Work
Templates that are running) and information about previous Jobs, as shown below:

Jobs can be paused or stopped if required using the buttons next to the progress bar for an individual job.
The list of Jobs on the Task Scheduler screen is cleared when the Vault is restarted.
Tasks that belong to the same Job are colour coded for clarity.
The Clear Completed and Clear Pending buttons can be used to remove jobs from the Task Scheduler that have a status of completed or
pending. This can be useful to simplify the screen if lots of tasks have been running.
The Vault cannot be powered off when there are tasks running. Wait for the tasks to finish, or cancel them before powering off.
Ensure that a reliable power source is used. If power is lost during the middle of a Job it will have to be started again.
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15.1 Manual Jobs
When a Work Template is set up to be triggered manually, it is available on the Manual Jobs screen, and the User can press Start to begin any
job:

If the required media is not available to start a manual job then an error message will be displayed.
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15.2 Alerts View
If there are Alerts that require a response from the User than an ‘alert!’ button is shown on the Task Scheduler screen:

To view a full list of alerts press the Alerts View button:

Press ‘Open Prompt’ for a to view details and make a decision on the specific alert.
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16. Library
16.1 General Library Info
The Library accessed from the Main Menu by default shows all media loaded in the Vault. The Library allows the User to view thumbnails or a
list of shotnames and key metadata:

To activate List View, click the List View button at the bottom of the screen.
If accessing the Library during a Media Check this shows only the shots involved in the Media Check and can be useful to assist the User in
confirming the results.
The information shown with each shot thumbnail is:
Roll – Roll name metadata
Chans – Number of channels of video, audio and timecode.
Start – Start timecode of shot.
Length – Length of shot expressed as HH:MM:SS:FF (Hours: Minutes: Seconds: Frames)

16.2 Editing Metadata
To view/edit metadata for a shot click on the thumbnail so the shot is highlighted in blue. Alternatively to work on multiple clips, select and
highlight several thumbnails.
Then click the Manage button and click Edit Metadata:
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The Edit Metadata screen shows the full range of clip metadata, divided into these tabs:
•
•
•
•

Filecard: a selection of common metadata most likely to be edited
Project: a selection of metadata about the project
All: every metadata item stored with the shot(s)
Shot Info: general metadata that is not editable except Pixel Aspect which can be edited for Anamorphic material

The first two tabs (Filecard and Project) can be switched to show different lists of metadata fields. For example, you may want to change the
order of the metadata fields, so that the most important ones for your project are shown at the top. Or you may want to add an entirely new
custom metadata field.
This can be achieved by editing XML templates stored on the Vault. Contact Codex Support for assistance with adding or customizing the XML
templates on the system.
Once there are additional XML templates on the system, you can switch between these by pressing the metadata tab heading a second time
when it is selected and showing a + symbol. This will open a list of the other metadata views that are available:
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Click in a field to make changes to metadata, then either Save & Finish or Quit & Forget to return to the Library.
Fields that are grey in colour cannot be edited.
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The top-centre thumbnail that is highlighted blue is the shot selected for editing. Click the thumbnail to the left or right to select that shot for
editing.
Click the Edit All button to select all shots for editing. When this is done any metadata that is common to all selected shots will be shown as
normal. Any metadata that varies between the selected shots will be shown as <mixed>.

16.3 Loading and updating CDL values
Copy your CDL file(s) to a device such as a USB stick and connect this to the Vault. Then select your shot(s) in the Library and press Manage>Edit Metadata->Load CDL. This will open a file browser - then choose the CDL file from your USB stick to apply to the selected shots.
The CDL file types supported are .ccc and .cdl and the first ColorCorrection element in the file is used. These values will be added to a shot (or
overwrite any current values a stored with a shot).

16.4 Setting the Pixel Aspect for Anamorphic material
All shots have a Pixel Aspect setting, and this metadata can determine how images are processed on the Vault and in some cases also how
the files are handled by other software. Files for editing such as Quicktime MOV and DNxHD MXF processed on the Vault will be desqueezed
based on this setting. ARRIRAW files have this metadata setting inserted into the file header and viewing applications can read this and apply
the appropriate desqueeze when playing back the files.
When shooting with the ALEXA XT it is important to ensure that this setting is applied correctly to shots when they are loaded into the Vault (in
SUP9.0 it is not possible to set this in the camera).
For material recorded on the Codex Onboard S there is an Aspect setting that can be set prior to recording. However, if this setting was not
correct at the time of recording it can be changed on the Vault.
To set the Pixel Aspect for shots first select the shots in the Library so they are highlighted blue, then select Manage->Edit Metadata. Once in
the Edit Metadata view, select Edit All and then select the Shot Info tab:

Select the Pixel Aspect field and a pop-up box will show the settings that can be applied to one or more of the selected shots:
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Choose the required setting and a summary box will show how many shots the selected changes will apply to:
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Select Save, and then Save & Finish to apply the changes. Back in the Library the shot thumbnails will change to indicate the new aspect.

16.5 Shots locked against editing
Shots involved in an Archive task will be locked against editing. When shots are locked in the Library a padlock icon is shown over the shot
thumbnail:

16.6 Deleting individual shots
When the Library->Manage options are opened there is also the option to Delete Selected, which deletes any selected shots. This option is only
available to Administrator accounts.
WARNING: Deleting a shot is an irreversible process so be very sure you want to delete a shot when selecting this option!
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17. Audio Sync and on-screen proxy playback
The Audio Sync option allows you to playback shots on the Vault in a small proxy window and synchronize audio files from an external recorder
to shots based on timecode.
Note: the Audio Sync feature is not compatible with RED RAW files. For other file types it is recommended to wait for the audio waveform to
finish building before starting playback.
When in the Library, select the shots you want to work with so they are highlighted blue, then click the Manage button and then Audio Sync.

If your shots were not recorded with audio the waveform area at the bottom of the screen will be empty:
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Click the Open List button and this will show a view of the available audio files. This will initially be empty:

Click the Fetch More... button to load files from an attached device, e.g. USB drive.
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Locate files, select them and click Continue.

Click the Auto Sync All button and the audio files will be sync’ed to your shots based on timecode.

Press the Play shot button to check the sync has been successful. You can step through using the Forward 1 frame and Back 1 frame
buttons to confirm this with accuracy and monitor via the headphone output of the Vault.
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If the sync is not accurate, look at the image and line up the Playhead with the clapper frame. Then use the Slip audio forward or Slip audio
back buttons to slip the audio in 0.25 frame increments to line up the Audio playhead with the clapper peak on the waveform. Then play the
shot to check the audio and video are correctly sync’d.
If required you can use the Zoom in waveform and Zoom out waveform controls for greater accuracy.
If there is more than one audio file matching to a particular shot, click the More button to choose which audio file to sync.
Once the sync on all shots has been checked press the Finish Sync button and then Confirm to finalise the changes:

This confirmation screen will then be shown:
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When an audio sync is completed a new version of the shot is created with the sync’d audio. The original shot remains and will have ‘(original)’
added to the end of the shot name, as shown at the bottom right of this image:

To continue working with just the audio sync’d versions of the shots for subsequent tasks (e.g. Archive or Generate) select the copy of the shots
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that have had (original) added to the name and delete them from the Library.
Note: any sections of the audio file waveform that are outside the timecode range of the video file will be shown in grey:
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18. Filter in the Library
The Filter option in the Library allows you to control the shots that are visible. This is achieved by applying a filter based on media location and
optionally metadata. This can be useful if you want to view or edit metadata on multiple shots that share common metadata, e.g. all the shots
from a Roll.
Click the + button to choose a location or metadata item to filter on:

At the top of the list are the options to Filter on Media and Filter on Source MUL which can be used if there is material from multiple MULs on
a single media, as is likely with the Storage module:
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Then click the + button to return to the Library View and click the Filter button to turn the filter on or off.
The remaining options show all metadata fields that are stored with the shots. Click on one of these to enter a value. For example, if we just
want to see the shots from scene 2 we would scroll down and enter this value next to the Scene metadata item:

Values can be entered for multiple metadata items and shots will only be shown that match the values entered for all items.
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19. Parallel Tasks
The Vault can use media for more than one task at the same time. For example the Storage could be used for both a Generate and an Archive
task at the same time.
We will look at an example of how to set this up. When making a Work Template there is a setting to the right of each Task (except for the first
task):

By default the first Task must finish before the second Task begins, and the second Task must finish before the third Task begins, and so on.
The setting on the right of the screen shows which previous Task must finish before that particular Task can begin. In the above image, by
changing this setting to None, it means the Archive Task does not need to wait for the Generate Task to complete:
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Now the Generate and Archive Tasks can run from the Storage in parallel.
Important Note: a Task is considered finished when it ends for any reason. For example rather than finishing as expected, a Generate task
could stop due to an error with the external disk (corruption, power loss, etc). If this happened the Vault would still proceed with subsequent
tasks in the template (because you may still want an LTFS backup despite the disk issue for example). It is therefore important to confirm on the
Task Scheduler that tasks have completed as expected and that no errors have occurred.
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20. Storage
The Storage screen allows the User to view general information about media that is loaded in the Vault. The Volumes section shows details of
the volumes that are loaded including their name, formatting type, location, status and the free space.
Before physically removing a storage device (Capture Drive or external hard disk) it should be ejected from this screen by selecting it and then
pressing the Eject button:

The Devices section shows details of the devices including all media ports and their status.
There are also options to Create, Load, and Eject:

The Create option can be used on unformatted Codex media to apply a name and specify the RAID type in order that it can be used by the
Vault, Onboard S recorder or ALEXA XT.
If an unformatted Capture Drive is inserted into the Vault an error message like this will be displayed:
“Error – Vault Codex data pack 3 contains an unformatted Datapack. This cannot be used.”
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21. Settings
From the Main Menu select ‘Settings’. This option is only available to accounts with Administrator privileges. This screen provides the following
menus:
21.1 Project
Here the Administrator can set the ‘Shot naming rule’ for the project. When using Codex Onboard S or M recorders, this setting on the Vault
should be set to match the Setup->Slate->Shot naming rule on the recorder(s). If not using Codex Onboard S or M recorders then this setting
can be left at the default.
This can be useful for batch renaming - when shot names are manually deleted on the Vault the ‘Shot naming rule’ is used to apply new shot
names based on the individual metadata items (e.g. Scene, Take) that are stored with the shots.

The Clear Media History button should only be used before a new project begins, as detailed in the earlier section ‘Preparing the Vault for a
new project’.

CODEX VAULT - ADMINISTRATOR GUIDE - 2014.r2.2027

PAGE 71

21.2 Users
This screen is used for managing user accounts.

To create additional user accounts select ‘Add a New User’. Complete the information for the user, such as Name, Telephone, and Email
Adress.
For an Administrator account select the Administrator button so that it is highlighted in blue. Otherwise leave the Administrator button so that it
is grey. Then select Save & Finish.
When logged in you can delete other accounts, but not your own account.

21.3 Network
The Vault has two Gigibit Ethernet ports, and optionally the capability to set up a Wireless Access Point for connecting remotely if the correct
hardware is fitted.
On the side of the Vault, Network Port 1 is on the left and Network Port 2 is on the right.
Click to choose if a Network port is Static or DHCP. When set to static you must manually enter the rest of the settings. When set to DHCP the
Vault should be connected to a DHCP server and it will be assigned network settings automatically.
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To set up a Wireless Access Point click the Off button and set this to Access Point.

Set the details for the Access Point to make it secure, and only provide these details to authorised users of the Vault. The password must be
between 8 and 63 alphanumberic charaters, with no spaces.
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The Access Point can operate at 2.4GHz or 5GHz. Click the 2.4GHz button to change this setting:

Note: when the Access Point is set to 5GHz equipment used to connect must also function at 5GHz. A 5GHz connection will generally result in
less interference from other equipment, but will also not penetrate solid objects as effectively.
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21.4 System

This screen is used for saving system log files, adding feature licence codes, and adjusting the system date/time.
If logs are requested by Codex support they will specify if they require Default level or Full level logs. To save the logs to a USB stick plug it in
and then click the Save... button and a file browser will appear. Choose the USB stick and then click Select to save the logs.
If you don’t have a USB stick available select the /etc/codex directory on the Vault system disk to save the logs to. To access logs saved locally
on the Vault the codexsettings samba share can be used. It is recommended to only allow more advanced users to do this.
For further details on connecting to a samba shared directory refer to the Codex guide “Getting Logs and Loading LUTs, Burn-Ins, and
sysconfigs”.
If you have been issued a licence code by Codex for a specific software feature, use the Add Licence button and copy/paste the licence code
into the box and click OK.
The timezone setting by default is UTC, which is equivalent to GMT. To adjust the timezone you can add an offset of between -12 and +14
hours. For example UTC-08 or UTC+10.
If necessary the Date and Time can be entered manually. After a change is made click the Save Changes button.

CODEX VAULT - ADMINISTRATOR GUIDE - 2014.r2.2027

PAGE 75

21.5 Interface

On this screen the Vault can be set to automatically lock after a specified amount of time. Once the Vault is locked then a user account and
password is required to log back in.
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22. Info
At the top of the Vault screen is an overall progress bar for tasks, and to the right of this is the Info button. The image below shows the
information displayed in the Info box:

22.1 Remote Connection (TeamViewer)
In the Info box there is a Remote Connection option. This allows you to connect to the Vault from another computer using TeamViewer to
observe and control the Vault. TeamViewer is available for free from www.teamviewer.com:

Before starting the Remote Connection connect the Vault to a network with internet access. On the Settings->Network screen set the network
port to DHCP and confirm that the Address, Mask, and Gateway fields are populated.
Click Start and a 9 digit ID should be displayed in the Remote Connection box. From another computer you can then run the TeamViewer
software and enter this ID and the password codex to connect to the Vault.
Press CTRL-T on your keyboard to disable the touchscreen on the Vault so you can use your keyboard and mouse via TeamViewer. Remember
to press CTRL-T again to reenable the touchscreen before disconnecting from TeamViewer.
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23. Using media with a clashing name
The Vault keeps a record of all recording media that gets loaded. When a Task is started the Vault will check that the name of the media being
used does not clash with any media that has been loaded previously. If a clash is detected you will be given the opportunity to rename the
media before proceeding.
It is strongly recommended to rename the media at this stage. If this is not done there is the possibility of files with clashing Roll and Timecode
information being delivered to post production which will cause a great deal of confusion.

24. Loading LUT files to the Vault
A 3D LUT (or 1D LUT) can be used to apply colour correction to files processed with the Generate Task.
Any LUT files should first be copied from another computer onto the Vault over a network. Follow the instructions below to do this.

24.1 Setting compatible network addresses
In order to connect over a network from another computer to a Vault the machines need to have compatible network addresses. This address is
called an IP address (Internet Protocol). The IP address is a unique address for each machine on a network.
Another element of the network settings is called the Subnet Mask, and this should match for all machines on the network. The Subnet Mask
can be thought of as a ZIP code, while the IP address can be thought of as a house number.
Unless the network settings of your computer and the Vault are already compatible, the settings on one machine will need to be changed.
On a Vault the network settings can be viewed and set in the Settings->Network menu.
On Mac the network settings can be viewed in System Preferences->Network.
On Windows the network settings can be viewed in Control Panel->Network Settings and then right-clicking to view the Properties of TCP/IPv4
for the network port being used.
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24.2 Examples of network settings
A Vault will typically have an IP address of 192.168.1.xxx where ‘xxx’ is unique to a machine, and a Subnet Mask 255.255.255.0. This Subnet
Mask means that for all machines on the network the first three numbers of the IP address should be common, and the fourth number should
be unique.
For example, if the Vault IP address was 192.168.1.123 then your computer could have an IP address of 192.168.1.124, and should have the
same Subnet Mask of 255.255.255.0. The restrictions of the IP address are that the last numbers cannot be the same, and must be within the
range 0-255.
With compatible network settings you can proceed to connect to the Vault.

24.3 Connecting from Mac OS X
This is achieved using the Finder application. Either press Command-K (Apple-K) or from the top menu select Go->Connect to Server…
Using the example Vault IP address of 192.168.1.123, in the ‘Connect to Server’ box that appears in the Server Address field enter:
smb://192.168.1.123/codexsettings
Then click ‘Connect’. Enter the username ‘codex’ and password ‘codex’ to connect.

24.4 Connecting from Windows
This is achieved using Explorer. Open an Explorer window and select Tools->Map Network Drive.
Using the example Vault IP address of 192.168.1.123, in the Folder field of the box that appears enter:
\\192.168.1.123\codexsettings
Then click ‘Finish’. Enter the username ‘codex’ and password ‘codex’ to connect.

24.5 Copying LUTs to the Vault
When the connection is made you will see various files and folders on the Vault, including a ‘luts’ folder and a ‘burnins’ folder. Copy your LUT
file(s) into the ‘luts’ folder and any customised burn-ins into the ‘burnins’ folder.
Be careful not to move or delete any other files or folders that you can see when connected to the Vault!

25. Full options for From and To Expressions
The options for these expressions are:
MediaPort
{MediaPort} can be:
Vault Onboard data pack
Vault Codex data pack 1
Vault Codex data pack 2
Vault Codex data pack 3
Vault Codex data pack 4
AXSM 1
AXSM 2
Vault RED 1
Vault RED 2
Vault internal 1
Vault internal 2
Vault removable 1
Vault removable 2
SxS 1
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SxS 2
SR Memory 1
SR Memory 2
MediaEmpty
{MediaEmpty} can be:
[0|1]
This is used with the output expression to only copy to empty media. A value of 1 means the destination is required to be empty before
copying. A shortcut to this is available through Add expression->Common Expressions, titled ‘Only If Media Is Empty’.
PreviousTaskMULList
A shortcut to this is available through Add expression->Common Expressions->‘Source clips: Same as previous task’.
{PreviousTaskMULList} can be used when there are several tasks grouped together in a Work Template. A task will process a group of
shots and the use of {PreviousTaskMULList} in the From expression for the next task means this will also process the same shots. Use of
{PreviousTaskMULList} in expressions is detailed in the next section.
InitialTaskMULList
A shortcut to this is available through Add expression->Common Expressions->‘Source clips: Same as initial task’.
{InitialTaskMULList} can be used when there are several tasks grouped together in a Work Template. The first task will process a group of shots
and the use of {InitialTaskMULList} in the From expression for any subsequent tasks means they will also process the same shots.
PreviousTaskInputMUL
A shortcut to this is available through Add expression->Common Expressions->‘Media: Same as previous task input’.
{PreviousTaskInputMUL} can be used when there are several tasks grouped together in a Work Template. A task will process a given media
and the use of {PreviousTaskInputMUL} in the From expression for the next task means this will use that same physical media. Use of
{PreviousTaskInputMUL} in expressions is detailed in the next section.
PreviousTaskOutputMUL
A shortcut to this is available through Add expression->Common Expressions->‘Media: Same as previous task output’.
{PreviousTaskOutputMUL} can be used when there are several tasks grouped together in a Work Template. A task will utilize a specified media
to output to and the use of {PreviousTaskOutputMUL} in the From expression for the next task means this will use that same physical media.
Use of {PreviousTaskOuputMUL} in expressions is detailed in the next section.

25.1 Syntax for From and To Expressions
When specifying the From or To expression manually it must be written with the correct syntax. If spelling, case, or spacing is incorrect then it
will not work. The software will not warn you if the syntax of the expression is wrong.
Here are some basic rules:
1. You must at minimum specify {MediaPort} followed by an equals symbol (=) and the name of the port in “quotes”. Examples are:
{MediaPort} = “Vault Onboard data pack”
{MediaPort} = “Vault Codex data pack 1”
2. There are no spaces between the words in {MediaPort}, and the M and P must be capitalized with other letters lower case. For example,
entering {Media port} will not work.
3. When specifying the name of the {MediaPort} there are spaces between the words. For example, “Vault Onboard data pack” is correct, whilst
“VaultOnboarddatapack” is not correct.
4. The asterisk * symbol can be used to mean ‘any’. For example:
{MediaPort} = “*”
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This can be useful if, for example, you want to set up a Work Template to run automatically when media is loaded in any port and the user will
then be asked to choose the port. Or you could be more specific:
{MediaPort} = “Vault Codex *”
This could be used to run a task on media loaded into any of the Capture Drive ports.
Here are some more advanced rules:
5. After specifying the {Mediaport} name you can combine other parameters with the following operators: and, or, not. For example:
{MediaPort} = “Vault Codex *” and {MediaEmpty} = “1”
6. You can use (brackets) in the expression too. For example:
({MediaPort} = “Vault Onboard data pack” or {MediaPort} = “Vault Codex data pack 1”) and {MediaEmpty} = “1”
This could be used, for example, to run a Media Clone on an Onboard Datapack or Capture Drive in port 1, only if it was empty.
7. The {MULList} option operates a bit differently. In order for a task to process the same group of shots as the previous task, use
{PreviousTaskMULList} in a syntax like this:
{MediaPort} = “Vault internal 1” and {MULList} = {PreviousTaskMULList}
8. In order for a task to process the same group of shots as the intial task, use {InitialTaskMULList} in a syntax like this:
{MediaPort} = “Vault internal 1” and {MULList} = {InitialTaskMULList}
9. In order to process the same MUL (physical media) as was used in the previous task, in the input expression for a task use either:
{MUL} = {PreviousTaskInputMUL}
Or, alternatively:
{MUL} = {PreviousTaskOutputMUL}

26. Using a keyboard and mouse with the Vault software
If you want to use a USB keyboard and mouse with the Vault, connect them and then press ctrl-T on the keyboard. This disables the
touchscreen allowing a keyboard and mouse to be used.
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27. Supported media types and file formats
The Vault supports the following media, file formats and compression codecs:
Company

Camera

Memory Card

File Type

Codec

Resolution

Bit Depth

Colourspace

ARRI

ALEXA

SxS PRO /
Capture Drive

Quicktime

ProRes 4444

1920x1080

12-bit

4:4:4

ARRI

ALEXA

SxS PRO /
Capture Drive

Quicktime

ProRes 4444

2048x1152

12-bit

4:4:4

ARRI

ALEXA

SxS PRO /
Capture Drive

Quicktime

ProRes 4444

2048x1536

12-bit

4:4:4

ARRI

ALEXA

SxS PRO /
Capture Drive

Quicktime

ProRes 422HQ / 422 / 422LT /
Proxy

1920x1080

10-bit

4:2:2

ARRI

ALEXA

SxS PRO /
Capture Drive

Quicktime

ProRes 422HQ / 422 / 422LT /
Proxy

2048x1152

10-bit

4:2:2

ARRI

ALEXA

SxS PRO /
Capture Drive

Quicktime

ProRes 422HQ / 422 / 422LT /
Proxy

2048x1536

10-bit

4:2:2

ARRI

ALEXA

Capture Drive

ARI

Uncompressed

2880 x 1620

12-bit

RAW

ARRI

ALEXA

Capture Drive

ARI

Uncompressed

2578 x 2160

12-bit

RAW

ARRI

ALEXA

Capture Drive

ARI

Uncompressed

2880 x 2160

12-bit

RAW

ARRI

ALEXA

Capture Drive

ARI

Uncompressed

3414 x 2198

12-bit

RAW

Canon

C500

Capture Drive

RMF

Uncompressed

4096 x 2160

10-bit

RAW

Canon

C500

Capture Drive

RMF

JPEG2000

4096 x 2160

10-bit

RAW

Sony

F5

AXSM

MXF

16-bit linear RAW

2K

16-bit

linear RAW

Sony

F5

SxS PRO+

MXF

XAVC

2K

10-bit

4:2:2

Sony

F5

SxS PRO+

MXF

XAVC

HD

10-bit

4:2:2

Sony

F55

AXSM

MXF

16-bit linear RAW

4K

16-bit

linear RAW

Sony

F55

AXSM

MXF

16-bit linear RAW

2K

16-bit

linear RAW

Sony

F55

SxS PRO+

MXF

XAVC

4K

10-bit

4:2:2

Sony

F55

SxS PRO+

MXF

XAVC

2K

10-bit

4:2:2

Sony

F65

SR Memory

MXF

F65RAW-SQ 16-bit linear RAW

4096x2160

16-bit

linear RAW

Sony

F65

SR Memory

MXF

F65RAW-Lite 16-bit linear RAW

4096x1080

16-bit

linear RAW

RED

EPIC

REDMAG

R3D

REDCODE (RAW)

6K

12-bit and 16-bit

RAW

RED

EPIC

REDMAG

R3D

REDCODE (RAW)

5K

12-bit and 16-bit

RAW

RED

EPIC

REDMAG

R3D

REDCODE (RAW)

4.5K

12-bit and 16-bit

RAW

RED

EPIC

REDMAG

R3D

REDCODE (RAW)

4K

12-bit and 16-bit

RAW

RED

EPIC

REDMAG

R3D

REDCODE (RAW)

3K

12-bit and 16-bit

RAW

RED

EPIC

REDMAG

R3D

REDCODE (RAW)

2K

12-bit and 16-bit

RAW

Supported audio files for Audio Sync are Broadcast Wave Files with timecode at 48KHz, 16/20/24/32 bit, from 1 to 8 channels.
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28. Cleaning the Transfer Module Air Filter
It is advised to periodically clean the filter on the air intake for the Transfer Module. This is particularly important if the Vault has been exposed
to dusty environments. Follow these steps to remove the filter for cleaning:
Turn the central plastic disk of the air intake anti-clockwise to remove it:

Remove the air intake grill. It is clipped in place but can be freed with a small amount of movement to the left and right whilst pulling gently. A
pair of needlenose pliers can be used for this, holding the grill near to the central disk:

With the air intake grill removed the filter material is visible. Carefully remove the filter material:
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The inner fan grill should now be exposed:

Clean the filter material using a vacuum, can of air duster from the inner side, or similar:

Then refit the filter material. When refitting the air intake grill, note the locating pin. This should be at the top of the grill when refitted:
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29. Setting up the Vault for a single tape Archive
To set the Vault to use only one LTO drive for archiving, follow the instructions below:
1. Connect a USB keyboard to the Vault
2. Open a terminal window by pressing CTRL+ALT+F2 and
3. Login as user=root, password=codex
4. Type the following command and press enter:
vi /etc/codex/ltfs_offloader.conf
5. Use the cursor keys to move down to the line:
num_mount_points 2
6. Press the “i” key to enter test insert mode.
7. Change the line to be:
num_mount_points 1
8. Press ESC to exit insert mode and then SHIFT+Z+Z (i.e. hold SHIFT and press Z twice)
9. Type the following command and press enter:
reboot
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Notes

24 hour support line +44 7985 467 665
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